GEMBA Note for Business 6 12th ed

Appendices of Manual for Beginners

Form Creation Manual

For Android ver users

B You cannot see and + >"Add Form components” in the note editing
section on Android ver. Please use iOS/Windows ver for adding and
setting Form components

B YOu can select/edit/approve the form components in Android ver which
are customized in iI0OS/Windows ver

Detailed description

e This document describes the GEMBA Note for Business for iPad ver(iOS 15, horizontal) so some functions may be
different from your GEMBA Note for Business,

e This document mentions the basic functions only. You can check either the User Manual or Administration Manual for
further detailed descriptions. Please follow the directions below on how to refer to the User Manual and Administration
Manual.

User manual: Click on the = icon on the top right of the screen in GEMBA Note for Business > User Manual

Administration manual: Click on the = icon on the right top on the screen in GEMBA Note for Business > Open Administrator
Tool > Menu > Download/Link

e The figures in this document were taken with = on the top right of the screen in GEMBA Note for Business > System
Settings > Display Settings > Display Labels on Buttons- OFF

¢ Please note that your notes might be difficult to read as the font styles will change if you open your document in different
OS environments. Please use Source Han Serif/Source Han Sans fonts to solve this issue.

¢ iOS is a trademark or registered trademark of Cisco in the United States and/or other countries and is used under
license.

e iPad is a trademark of Apple Inc.

e Windows is a registered trademark or trademark of the Microsoft Corporation in the United States and/or other
countries.

e Other company names and product names are registered trademarks or trademarks of their respective companies or
trademarks of our company.

e This manual was created by MetaModJi corporation and the copyright of this book belongs to the MetaModJi corporation.

e The contents of this manual are subject to change without notice.

July 4, 2023 oMetaModJi Corporation
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1 . Introduction

As an administrator, you can create and prepare forms for users to avoid filling out or
pasting the same contents repeatedly

Forms can improve your work productivity and is a time & effort-saving tool. You only
need to do simple operations to get clear documents at your construction site. Thus,
there is no need to go back to your office and create documents on a desktop

Reading a barcode

Barcode field

Show automatically Problem management tabjle
Numeric ]_Cleld No. 2018032200 | | Approval | TBC Select with a tap
Date & Time Input ® )
hate 2024/01/01 % oo @— Approval field
ember John Doe
m_ nspection type u\spection time q_ot no. Quantity
Single-line Text ——@Machining L20PM 4901567014010 Numbering field
Problem @ ConstructionA O Construction B ®—| Selection field
. O Image field
Enter image here
Remarks
Enter text here
Multi-lines Text —@
G o |
Button field

As an administrator, you only need to select and place form components to get a form
(no need to program with codes)

You just need to edit a little bit if forms need to be modified for different construction
cases. This function can thus save the administrator’s time



1-2 How to Make Forms

First of all, you can plan the layout of your finalized form and prepare the basic format
while taking certain things into account, such as what kind of form components or

tables will need to be added to units

Step1 Preparing the Format

Quotation pate Method 1: Load a PDF file in Method 2: Create the format
Expiry Date: GEMBA Note itself in GEMBA Note
ABCInc. Load and use a format saved Insert shapes/photos/texts to
as a PDF file that you created create a format in a new page
in other apps to GEMBA Note — of GEMBA Note — P6
P5

Remarks

Step2 Change Settings with Placing Form Components/Tables

Quotation Date: Enter date here

Expiry Date: | Enter date here

Enter text he Inc. @] Ji
Total ot
: Form components ]
TEL ter te -

Mr/Ms. | ¢

ProductName  Quantity |UnitPrice  Amount

.—[ Spreadsheet(units) ]

pee » Placing form elements/units (P7)
emarks
! » Customize form components (P14)

Step3 Saving forms as a template

Forms that were created can be used as templates and shared with team members

» How to save the form as a template and use

How to use a form

When you add a page, select the form
that is saved as a template

» How to use a template (P12)




2. Preparin

Method1

g a Format

: Load a PDF file in GEMBA Note

®Open a PDF file in
other apps

This example is explained
with Mail app.

O Plese open a note in
GEMBA Note in advance if

you want to add a PDF to it.

@Tap and hold the PDF

and select “Share”.

nthe e

Open in New Window | &3
. Markup and Reply ®
19

Save to Files

Share (i

Copy ®

(®Tap "GEMBA Note 6" |

" agreement for the roo|
E  PDF Document - 278 KB

A=l

AirDrop Mail GEMBA Note 6 Drive

®

m endah prome...

Copy

©In case you use other apps, Please proceed to @ after sending a

PDF to GEMBA Note

[@Select how to import and tap "OK”.]

| Cancel

Add to the note that was
opened as a new unit

—

Select how this PDF file is imported.

Import Done ‘

() Add As PDF Unit
To Next Page »

>

_. D Add As Page(s)

page

Add to a Note as a new ’

’D Create New Note
. D Illj'r:)pf;;;f‘tter converting to N-
q Add in Planview Linkage Paper
- .
Please check on"Appendices
of Manual for Beginners: Put
a pin mark on a blueprint and
link to a construction photo
|| (reported area)”. (eYACHO)

2 pages (... >

.

—_

Select one if you are asked to
either import to your private
folder or the current folder,
it will be imported as a new
share note if you choose “Yes”
for the question “Create a
new share note?”

Convert multiple pages as one page.

Cancel N-Up Settings Done

Paper Size Letter - Landscape >

Pages Per Sheet 2 pages () >

Page Border O
Cancel Pages Per Sheet Done
1 1page
1 2 2 pages (=)
2 1 2 pages (¢)

1 Ammmnn 11

Select the page to add a location

| Cancel Import Done

. - ]
{
\

To Today's Diary Page
To Top of Note Page

To End of Note Page

More Settings

v

Select "Rotate” and “Location on a
page’

Cancel Done

Import

HyE &

1800 270°

If You Select Note Overall Screen

The screen below will be shown

Done

Cancel Import

Select how this PDF file is imported.

() create New Note

() mport after converting to N-

Up Layout 2pages (.- >

storage

O Select + > “Load from files”
for Windows/Android users

How to Import From Other Storages

Select + > import> select a PDF from a




Method?2 : Create a Format in GEMBA Note

®Tap “Create a new note” in [@Select a note]

All note - .
s reate Note
= Keson : .—[ Type a note t|t|e]
¥ Home @ Home >|Private Folder :
Packages
) Private Folder @ [B—% @ ' Z:;;r::::es
oY - = == _
) Team Folder ‘ = E |— -

Create Note

nnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnn

You will see the note modify the page and a new
note is created
Edit and create a format

© For editing a note, please check = > User manual

Add Headings/ When you tap s >turnon # ,the
Qu ion Date: i Categories lines you draw will be linked to a

. Expiry Date: Tap T and type your graph paper

ABC InC. texts E“w pf; v% Eréafe TI‘
Add a Borde I a
+>Addshepeand 7 [ ny’t E@ s-;fl}?t I
choose/draw a line
with the “write” —_— — —— ]
command o gg, N B

[ )
k
Remarks How to align a shape/text box
B Drag a box to align
change a box size

O]

[ D R EGRETTTEEE °
'

Swith on/off “guide”

When you drag a shape/
text box while it is the guide
is on, auto-alignment will be
shown

@-------ooo- @ oo °

O]

When you drag with @ , the text
size will not change, but the box
size will change

B Tap s > circle multiple shapes/text boxes> select
“Alignment” and choose an option

Expiry Date

When you drag with ® , the text Quotation
size will also change along with a

bOX size Enter text here
Expiry Date




3. Place a Form Component/Unit

3-1 Place a Form Component to Customize Settings

®Press B @ = >Select a from component that you

!

want to add
) i
| | ™ Y A form component that you select will be added
Add Form Components [E\_ X X
-
. (T2 oneorton meric Change the display settings of form components
.z @ Single-
2 line Text Text Add Form Components Add Form Components
= Selection e ot = /: Checkb
P Vi T = v Checkbox
Date Display Image R R Number Input Field
>! Movie £ PDF .’;'53 = Text Input Field
< mz::er +: Button e e . . Text Area Field
% Barcode Numbering e A & E2 - Selection Field
Approval | e
2. Signature
L ),

Batch Add Form Components
- Add Form Component by

+ >"Add a form component” also M;;::;:TZM feetanle » Add the form components by recognizing rectangles (P8)

allows you to add a component #. Manage Shared List » Register and use Shared list (P39)
B » Register Numbering settings (P31)

As Android users cannot see or
+ > “add a form component”, you
need to use the I0OS/Windows ver to & > "Layout” and change the
do so =] width/place of the Tool Box

[@Change the settings of form componentsJ

¢ MNo. * patefmime ® Place TBC

@ The Tool Box for changing a layout will be shown

(R * "J
Enter text here 9
= [ Entertext here
= 'y - ]
Arrange so as not to Overlap _ No.  DatefTime  Place
o = Arrange ) Arrange o e dae o text
5 = Vertically " Horizontall i i 3
® & Align Horizontally DAfP/TImP o *
- R - - :
° . ° v hs - = ‘
: O ' Align Vertically Enter number here Ems’d‘“h“ || HiErekEiEe |
~ . HH w w " .
g (: Q\D ) :) wm f i e uEMm
| | Align the Size 4 ‘ —
'3 ) =, Align Width | 18 Align Height s
) = L Ll <Dare/Time o
® Size (mm) H
Width of the Field ~ 33.9mm > ® || Enter number here |fi Enter date here | ¢
Height of the Field ~ 5.6 mm > i I H No. Datefime Place T8 Cheekbox Nme
»-+ * ] u]
Duplicate E
Duplicate - Duplicate o
Verticall Horizontally =
Temporary Operation » How to lock (P1 O) =

() unlock Al Locks

(] Highiight Form
Components

You can select multiple form components to change all at once

Tap ¢ > select multiple form components to change the setting at
‘once

You can customize a size/order of a form component

¥ You can change field settings with the tool box LAltSSsatg=geiRielgukeelyyslelg o G

i |+ o) i ™" | specification: Specify a text size with
Left/Right:2mm
Field Settings Top 00 | (mm) num beFS
g | | o toe > Automatic: a text size will be changed
Background Color None > a2 20 g i
@ " : automatically
. s ) ‘e Conditional Formatting None > - 3 . . . .
e om iP5 Morgn  LefqRightzmm > o Ranges: Specify a min/max text size which
i ° . M Display Settings 1 23 4—' will be automatically adjusted to a size
O] Label ? of the form component
Checkmark Display Checkbox >
- 1 23 Cancel Text Size Done
Text Style L.
Alignment Horizontal Align L... > T Specification “ Ranges
Alignment Vertical Align Mid... >
4 8 m 24 48 96
I I |
1z 16 24 32 56




Add a Form Component by Recognizing Rectangles

You can add a form component by auto-recognizing a table in a PDF that you

uploaded to Note

) & &y

Add Form Components

4

H
H
3
3

~ Checkbgx Numeric

Basic

ioh

Date Display

1 Movie €

Phone
Number.

(8

Button

i

.. Barcodd Numbering

Approval

Approvdl S

< signatufe

Batch Add Fl) Components
1+ Add Forff Component by
™ Recognizing Rectangle

auto-recognized, then tap ”DTe”

1.0pen a page that you want to place a form component and select “

2.Select a form component that you want to add (drag @ ) as they will be

Your chosen form component has been added

compornent

Field Type”

B Checkbor

Changing a Form Component
Type

1.Press & to circle a form

2.Select a type from “Change the

‘Bew

If some of the form components have been
added, they will be colored red. So, drag @
and choose only the green colored ones as
it means they have not been added

3-2 Check the Form Component’s Operation

T: f t
®Tap a form componen [@Check the operation by testingJ

» The setting of form components (P14)

Date
Expiry Date

2024/01/12
Enter date here

Clear the data

< Jan 2024 >

TUE WED THU FRI

Date 7 8 9 10 M 12
EXp” 1w 15 16 17 18 19

13‘2_

20 | 1EIE

Clear the data after an operation

check

1.Tap ¢ and circle the form
components that you want to
delete/clear

2.Select “Clear the field data”

S S

etaly

111 |- 1111

MetaMoJi GEMBA

il MetaMoJi

Enter text here

Enter text here | -

Enter text here

TEL | Enter text here

Mr/Ms. | Enter text here

TEL J 03-XXXX-XXXX

Quantity

Mr/Ms. | John Doe

Unit Price

Amour




3-3 Add a Spreadsheet (Table)

You can add a table to use like a spreadsheet. You don't need to switch apps as GEMBA
Note allows you to enter your data for calculations on just your note

[@ + > select “Add Spreadsheet"J @double tap to enter or set

® a formula

85 + ‘ ‘ Note

Add Page )+ sEmEm =[]

@@ Add Item =7 [s o+ » ax =

EE] Add Spreadsheet 4[5 6 x = & <

Calendar rostine ; a2 + : ':‘ I

NG Add Shape

[N Add Photo

Add Video

§  Add Audio Unit T

@ Add Web Page Remarks )

©: Add Note Link

L{r} Add Form Control

T Add Planview Check out on a spreadshteet function/formula with =
BE Fiter > User manual

1 Import You can also add a conditional formatting/data

validation/chart

How To Hide a Header How To Merge Cells

@roductName  Quantity  UnitPrice | Amount 1.0rag @ in a cell range that you want to merge
Product Name Quantit; Unit Price
e ‘ProductName ‘Quarm'ty UnitPrice Amount :
¢ .

"

2.Select "Merge” in the bob-up
Fi 3 "roduct Name Quantity Unit Price

1.Tap & and circle a spreadsheet
2.Select “Spreadsheet”> “Hide Header” N — Iy

P Lock spreadsheet How to increase/decrease a row/column
Hide Header alendar >

| vide Mines [ Insert rows ] Delete rows ]
Chart Afea

Product Name  Quantity You can hide
a border

If you don’t want to change the values

' You can drag® to insert/
You can protect a chart if you don’t want » delete a row/column

to change the formulas [ Delete columns ] ' |
1.Select a cell which allows you to edit a

value f

2.When the pop-up shows up, select “Cell

|
|
I
|

formatting”> turn off the “Protect cell” ¢
function
3.Select a chart and choose “Chart"> [ Insert columns ]

“Protect a chart”




3-4 How to Lock a Form Component

You need to lock it after placing. You can avoid mis-editing (drag/deletion/size change/

rotation) by locking your form component in advance

@You will have three options displayed to you from the pop-
up. choose "More”>"Disable Selection”/“Lock Position“/”Lock
Size"/"Lock All”

®Tap & and circle the
form component that
you want to lock

.
= Group 2 ¢ =

Cut Copy Remove Alignment > More >

Disable Selection = |£%3 i

Flip Top and Bottom
You can disable a selection for a photo/ g o Fron | [ mman e
shape/form component by locking Date: o | ey .

You can input/select a form component

Register to Item

¢ < Expiry Date:

Add to Toolbox

Align Vertically
m " m

Align the Size

. Disable Selection ‘= Align Width | §¥ Align He
Lock position Size mm)

Width of the Field Mixture
You can lock dragging/deleting/ 1 oIl Lock Stz Height of the Field _ Mixturd
changing or rotating your note’s L | 03-XXXX-XXXX Lock Al Duplicate
size r/Ms. | John Doe omenene Tmplyo“ Aol

You can type/select a form
component and also change copy/
group/overlap

Lock Size

You can lock your note to avoid
changing its size and to prevent you
from accidentally rotating it

You can type/select a form
component, and also change
settings, dragging/deleting/cutting/

copying

Lock All

You can lock everything to avoid any
changes

It is used to not move any format's
borders/lines

How to unlock “Lock Position“/“Lock Size”

1.Tap & and circle the form component
that you want to unlock

2.When the pop-up is shown, Select
“More”> “Cancel Position Lock"/"Cancel
Size Lock”

Unlock all the locks temporarily

Display Editor Info

() unlock All Locks

]ntity Unit Price A Display Author Label

() Highiight Form
Components

You can edit a form component after turning on this
function. When you it turn off, then it will be locked
again
Form components will be locked automatically
when you go to another page

J

You can color a form component to note something
remarkable there

You can check a position/type of a form
component by turning on this function
SO it can be colored to be remarkable

EAtéYAumber here

How to use the “Disable Selection”/“Lock All* functions

1.Tap down the form component that you wish to unlock
You need to tap each form component one by one.
You cannot circle to select multiple form components
all at once if their selection or the note themselves are
all locked

2.Select “Unlock All” on the pop-up menu

MetaMo it
Unlock All  Unlock All in Page

TELE \ 03-XXXX-XXXX 1
Mr/Ms. - John Do I

Tick “Unlock All
Locks” to unlock all
form components in
a page




4, Register/Use As a Template

You can register your form as template, thus when you add new page, you can select
it and it will follow that saved template.

4-1 Register As a Template

®Tap then select the @Press down/right click on the page, then
page/paper in the page choose “Registrate/Create”> “Register Paper
list you want to register Template”
as a template S

Register Paper Template

Create PDF Unit from Background PDF

Step3 FYIU—hELTEBRTS

CEZ]

=

®Enter the “Template @Select the template to be either “My
Name” Templates®/"Shared Templates”

l My Templates

Test

| ‘My Templates” are for private
O e templates only visible for you

() shared Templates (Not Specified) > |

Number of Pages:1

' Shared Templates
g — “Shared Templates” are for public templates shared
- with your team members

= The template saved can be shared among all of your
= members if you select (Company-Wide Folder)

You cannot select Team Folders if you have done the
operation in All Note

- Long-tap “Team Folder” then select “Team Display
Settings” and untick teams

- Long-tap a folder then tap “More"> “Folder Display
Settings” and untick

[@Tap "Done”]

You will see a message telling if a new template name has been already used

My templates Shared Templates

Will be registered in the Will be registered in the list of “Shared Templates”
list of "My Templates” Will be visible in the lists of your other team members



4-2 Using a template

[@When editing, choose + > “Add Page”> “Add using Paper Style”J

@Select a template in the lists of “My
Templates”/“Shared Templates”

The one you selected will be added as the
template for the note

Close Select Paper

> History

~ My Templates

Daily Report

> Shared Templates
» Packages
> Basic Templates

~ GEMBA Templates
|

5 2 E 3 =

Work Order Incident Report Vehicle Inspection Report Meeting Agenda Equipment Inspection
Report

@ a

How To Change a Template Name and Check the
Template Info

Press down/right click on the template and select
“Template Info”

™ You can change a template}
Form components.

name

and “Registered User”

{You can check “Team to Share”,"Registered Date’l

How to see the latest version of the Shared
Templates list

1.Select : > "Update” j
Close. Select Paper
{7 Update

s

Bp Edit

Use Basic Templates

Use GEMBA Templates

Q, Use search

[SRNHSEN]

"= Hierarchical Display

Now your Shared Templates list is up to date. You
also can see changes if other team members edit/
delete contents(templates) inside

@Tap % > select the form
component/unit then enter data

. . ‘ @ E{-
T Date: 2024/01/01 |
Expiry Date: | Enter date here | i
ghers Inc, ‘ Ij.“ Mete < ‘ Jan 2024 >
Total

111 _ 1111 3 1 2 3 4 5 6
TEL | O3-XXXX-XXXX |7 8 9 10 m 12 13
| Mr/Ms. | John Doe

4 15 16 17 18 19 20

Product Name Quantity Unit Pric| 22 22 23 24 25 26 27

How To Update/Delete a Template

In order to update a specific template, you
need to register a new template and delete
the form already registered. (You cannot
update a template that is already registered)
The Steps for Deleting a Template

1.Select ¢ > "Edit”

Close.

Select Paper : E
_—
& Update |

Bp Edit

Use Basic Templates
Use GEMBA Templates

Q, Use search

[SRNHSEN]

"= Hierarchical Display

2.Tap the template you want to delete and
select “Delete”

Select Paper Done

3.Tap “Done”




4-3 About Default Templates

When editing, you can select a useful template by + > “Add Page”> “Add using Paper Style”>
"Default templates (GEMBA Templates)”

Close Select Paper

Open showcase (Papers are Available Online) |

> History
» My Templates

» Shared Templates

Packages

Basic Templates

«

GEMBA Templates

5] j— —
= —
Work Order Incident Report Vehicle Inspection Report Meeting Agenda Equipment Inspection
Report
Transmittal Drawing Request Inspection Sheet

88 @ Q



5.Settings of Form Components

You can add a new form component and also change the settings of the form
component you added. In GEMBA Note for Business 6, you can select multiple form
components and change the settings all at once

5-1 Checkbox

®Tap & to show the [@Select +> ”Checkbox"]
toolbox

A new checkbox is added

®
| @ iy
Add Form Components

5.
g % /! Checkbox 7 Numeric ke
3 8 = Single- o
© line Text &= Text
= N -~ Date and
= Selection ) Time Input
%] Date Display | ' Image . .
L You can tick/untick a
= ! Movie # PDF )
@ - checkbox with taps
‘o nnone i+ Button
“~° Number o
= Barcode " Numbering
= Approval
© Approval " Reanast

@ Tap & then circle [@Tap > &i?] ®Customize “Field

a checkbox l Settings”/“Display Settings”
| @

el > Add Conditional Formatting (P42)

Margin Left/Right:2mr
@ Display Setings You can add texts as a
e 9 - Iabel aftr a tickbox

] . Display  Mixtur
i | @ Checkbox Toxt sty
c v Check Alignment Horizontal Align L.

Alignment Vertical Align Mid.

¢c * DTBC $00
You can select one

5-2 Numeric Field

®Tap B to show the [@Select &> ”Numeric”]
tool box

® L )
Now a new Numeric field is
e | -] 7
| & 8 added

Add Form Components

(3) o L .l 2 @eeesrereecer e
T ‘@ . Checkbox 17. Numeric el O, ’
@ o ; -
E . Single- = Toxt G G 4 :[ Enter numberhere | ¢ D D
5 2 line Text = ! er——— |
P -+ Dateand @;monomnncns S ®
= Selection - Time Input ®
[*] Date Display | ' Image
Q o=y . can
) .#. Movie £ PDF
3 -, Phone [
LJ; Number . Button
= Barcode ' Numbering
& - Approval
=, Approval 2 pomnact



[@Tap & and select a Numeric ﬂeld]

[@Customize “Numeric Field Settings”]

[@Tap & >y ] Display Settings
Display Format
s
Fleld Settings Cancel Display Format Done
» Add Conditional i Nore > You can You can
: S| | sackgromdcolor  Nore > o Clear valu delete values
® Formattlng (P42) Conditional Formatting None > Niotior S BodimaiElioes e|S
' . Margin Left/Right:2mm > 2 = 1022.5%5
¢ ¢ ¢ Enternumberhere ¢ D D oispiyserungs S—— @) 7 8 o
@ omormonememnma B e o Display Format 1234 > . 1 02256_]
® Text Style
N 1 2 3 /e
St > ~
o ©
Alignment Horizontal Align... >
Alignment Vertical Align Mid... > T
Display by Barcode ~ None > [ You can lock the value ]
Edit Settings
Input Method Numeric Keypadf——
O | choromsetingetvmorcke.. > Prefix/Suffix
Place Holder
S You can set a text shown with a value
Cancel Prefix/Suffix Done ,I 23
P’:ﬁK 7 8 9 [o]
; ) : o Ce o i A1zssj
Select “Input Method You can customize the .
to customize display default text settings o . ©

settings. Select
“Change Settings” to
change the values in
“Minimum”/“Maximum”

pefore entering

Enter numeric values here

QR code

Display by Barcode

You can display entered values as a barcode/

Cancel

Display by Barcode

Done

Display by Barcode.

None

co & {00 AR

() QRrCode

Edit Settings (Input Method)

Numeric Keyboard

You can set a minimum/
maximum values

Cancel Numeric Keypad Done
Minimum
1
Maximum
10
12

You cannot lock values
which are out of the range

Select from “"Define list”

Clear Value
1.00

2.00
Enter num 3o

4.00
5.00

P Register/use a shared
list (P39)

O =0
B
Stepper
Canee] L Done Cancel Stepper Done
Options Increase / Decrease Value
Define List > 2
(O use shared List > ._ Minimum
0
Maximum
Display Clear Button O 10

8. »
B Tap to increase/decrease
values as you customized
B Select “Display Settings”>
“Alignment Horizontal”> “Align
Center”




5-3 Single-Line Text

®Tap B to show the

[@Select i >"Single-line Text"]

toolbox

i

Basic

Basic

®
|@%ﬁ

Add Form Comgonents

Now a new Single-line
Text is added

] —

Checkbox Numeric | ) |
o G G ¢ Entertexthere ¢ 9
-+ Single- ‘ 0 Text ' '

line Text - ( Dt *

‘= Selection ® ?ﬁee?::ut

- : Tap to select from the
[*] Date Display Image .

% Movie g list or enter texts

Phone
2} Number . Button
%. Barcode Numberina

@ Tap & and circle a Single- [@Tap > 1Y ] ®Customize a Single-line Text

line Text field

4 o S =
\/E::v Pfin( Wri Eréaze Se?ect T-e|:| @ @ do ﬁ>‘ -
.5 &
Field Settings
o Border None >
3
@ o Background Color None »
[ S @ 14 Conditional Formatting None >@
i Enter text here ' Margin Left/Right:2mm >
s e ‘ Enter text here R Display Settings
> !
! |_Enter text here ' Text Style
i | Entertext here Alignment Horizontal Align L... >
L e [ Alignment Vertical Align Mid... »
O]

None > @

Display by Barcode

Input Method Keyboard and... >@——

» Register/Use it Settings
Shared List (P39) List Setings N

You can set the maximum
number of texts

!

You can turn on Alphanumeric Input as
it is useful to enter e-mail addresses

ElCENEAE

How to show an account information automatically when using an item/template

Name: John Doe

GEMBA Note)

register 1.as a new item

Place Holder
Maximum Length 100 >
Alphanumeric Input No »
Edit Possible >

o Item/Template Settings

Initial Date

1.Select "Item/Template Settings”>Initial Date When used > Name (the category
that you want it to be shown automatically from the account information in

2.Press down a Single-text Line field and select “More”> “Register Item” to

3.Select the item created in 2.by + > “Add Item” thus the Single-line text field
which automatically displaying the category selected in 1.will be added

If you create a template with a page containing 1., when you open the template,

the page will be open and show the category automatically customized in \

Il » Register/use as a template (P11)

—

field settings

» Add Conditional Formatting (P42)

Display by Barcode

You can display a URL entered in a Single-
line Text field

T g

You can select choices from the list when you choose “List”

from the list when you choose “Keyboard and List”

Clear Value
Train
Taxi
Buss
Vehicle
Bullet Train
Airplane

iere I

You can enter texts with a keyboard or select choices

| Textstyle

Alignment Horizontal Align L... >

v Date When

Name
Alignment Vertical Align Mid... >

Organization Name

Display by Barcode ~ None >

User ID Edit Settings

Organization ID Input Method List >

Email Address List Settings Train/Taxi/Buss/... >

Place Holder
Title L
Maximum Length 100 >
Team Name
Alphanumeric Input No >
Folder Name Edit Possible >

Tagged Folder Name “sm/Template Settings

I Initial Date When Used Date... >




5-4 Text Field

Add a Text field which are allowed multi-lines

®Tap B to show the [@Select &+ > "Text”]

toolbox

.

Basic

3
|TM?$

Basic

Add Form Components

A new Text field is added

/! Checkbox | | {7}
-2, Single- ‘
~ " line Text

"z Selection ‘ #;
[*] Date Display‘ )
© Movie |

Phone
° Number

| |
! Barcode ‘ 3
REE

' Approval

= Text @

Numetic

Date and Tap to enter texts

* Time Input

Image
PDF
Button

Numbering
Approval

Reniiact

text field

®Tap & and circle a [@Tap >%i?]

L

Point

®
®--------- et °
e Enter text here H
@-------ooooooe L it R J

% o
e

@ Customize the settings
of a text field

Field Settings

Border

Basic

Background Color
Line Feed

Line Style

None >
None >
12 >

None >

Display Settings

Text Style

Edit Settings

Place Holder




5-5 Selection field

You can select an option by tapping on the field

®Tap & to show the [@Tap > ”Selection”]

toolbox ® P
N o A new selection field is added
Al
5 Add Form Components
)
'2 /. Checkbox . Numeric
a -
=, Single- o
© line Text = Text
rzn . -+ Date and
© - Selectlon. & Time Input
2} 0
g [*] Date Display | ' Image
= Movie . PDF
-+ Phone )
" Number +. Button
. Barcode "1 Numbering
© Approval || Agerov

@Tap & then circle a [@Tap > §Y ] ®Customize the settings of

selection field a selection field
& 4 L&) L I23E Y S Il Choose Layout
| He mList
Field Settings @ Report
@ Border None >
@ O Error
. a Background Color None > O ReqUeSt
Margin Left/Right:2mm > .
O] mTile
Display Settings
| A ® Layout Tie > @—| Report [JEror [JRequest
i : Text Style B Selected
\‘: (: ; + :) Alignment Horizontal Align L... »
H E Alignment Vertical Align Mid... >
s i Edit Settings Report
e e ¢ Select Method Radio button... > Error
@ Request
List Settings >

Select Method P Register/use Shared

List (P39)
m Radio button (single)

@Report  OError O Request
m Checkbox (multiple)

Report [JError [JRequest




5-6 Date and Time Input Field

You can enter date/time with this field

[@Tap to show the [@Tap > Date and Time Input ﬂeld]

toolbox ® . _—
=l = A new Date and Time Input field is added
™ It S
@ o .
‘ L EI el o ‘ Enarckichan * 00
- o . Checkbox {7 Numeric L VAR Y
a Single- oot ®
! line Text = Text
) "= Selection ) ‘I?ian:e;::ut
c".tg [*] Date Display | ' Image
‘®' Movie # PDF
Z e, |4 Button ®Tap the Date and Time
= Barcode ! Numbering | .
nput field
© Approval © :‘f”:ﬂ‘:‘f p

[@Select a date]

< Jan 2024 N The dafte you selected is shown
SUN MON TUE WED THU FRI SAT ln the fleld

31 1 2 3 4 5 6

7 8 9 10 M 12313 2024/01/12

14 15 16 17 18 19 nere
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®Tap & then, circle a

®Customize the settings of a Date and

@Tap & >
[ ] Time Input field

Date and Time Input

field

\I}i)é\jv Point  Write  Erase |S\:§e:’ct Text @ @ ndo H;i>n E E D|Sp|ay FOI"mat
+ & m Date Only

Field Settings Cancel Display Format Done
o Border None > Time Only | Date and Time
$ Date Format
o Background Color None > 2024/05/01

© ® Margin Left/Right:2mm > 02450
’ ___________________ , 24I08I01
H ) . .

> o P Display Settings .

G G ¢ Enterdatehere ¢ 9 m Time Onl

> . . y

i P Display Format  2024/05/01 ).
. __________ Q- L ] Cancel Display Format Done
Text Style
@ Date Only Date and Time
Prefix > )
Suffi)( Time Format

Input Method

=

Alignment Horizontal Align L... >

Alignment Vertical Align Mid... >

Date Date When Registered »

3:00 AM  (Locale Dependent Format)
03:00

3:00

H Date and Time

Display by Barcode None >
Edit Settings Cancel Display Format Done
———— @ Input Method Picker » Date Only Time Only
Date Format
Display Clear Button No > 2024/05/01
20245
Place Holder o
24/05/01
Item/Template Settings 20240501

2n24-0R.N1
Time Format

3:00 AM  (Locale Dependent Format)

03:00

Auto-diplay settings when you use an item/template

20

You can customize it when you You can auto-diplay a Date and Time Input field linkage
select "Display Format”™> “Date to the page/the date of use
Oonly” m\When you open the registered form as a template
m Calender P Register/user as a template (P11)
< Jan 2024 > m\When you add the registered Date and Time Input
SUN MON TUE WED THU FRI SAT _ﬁeld aS an |tem by + > “Add H:em”
31 1 2 3 4 5 6
Cancel Date of Use Done Cancel Date of Daily Page Done
7 8 9 2 1" 12 13
12|15 6| | 18| 19 | 20 E Specify Relative Date Specify Relative Date
Year Month Week Day Year Month Week Day
21 22 23 24 25 26 27
28 29 30 33 1 2 3 2 mv kw((;u\ 2 ;ta\//s \;efc;r“e
1 days before 1days before
4 5|6 7 89|10 Added Date The day of Diary Page
1 days after i 1 days after
m Picker 2 days after 2 days after
Select Date Done -
9 October 2021
10 November 2022
1 December 2023
12 January 2024 :l
13 February 2025
14 March 2026




5-7 Date Display Field

Auto-display the date which is set based on The day of Diary Page. You can use in a
Diary Page

®Tap B to show the
toolbox

@Tap i+ >

“Date Display”

r@éif

Add Form Compohents

¥

A new Date Display field is
added and will display the date
of the Diary Page

o . ves .
‘g v, Checkbox 2. Numeric
o -
-~ Single- P
© line Text = Text
nz : -.- Date and
o = Selection . ) Time Input
% [*] Date Display | ' Image
o . ; .
. Movie £ PDF
. Phone e
* Number i Button
= Barcode "' Numbering

~ Annraual

®Tap & then circle a
Date Display field

o
e & # O 5| T
View  Point  Write Erase |[Select| Text

g Border None > .
& You can select the display date
@ Background Color None > ‘
Cancel Day to show Done
Q- - Q@ ® Margin Left/Right:2mm >
> . | . . Specify Relative Date
3 G ¢ 2024/01/12 B Display Settings FETTEETE
P S P ® Display Format  2024/05/01 >

@Tap & > %i?

|l

% E Re’b
+ ®

Field Settings

Day to show The day of Diar... » o—

Text Style 1days before

! The day of Diary Page
Prefix > 1 days after
Suffix

@ Customize the settings of
Date Display field

s days before
2 days before

2 days after
2 days after

Alignment Horizontal Align L... >

Alignment Vertical Align Mid... >
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5-8 Image Field

®Tap B to show the
toolbox

5

Basic

[@Tap > "Image”
e
| @ 1y

Add Form Components

(=

) . .
'g v Checkbox 2. Numerjic
o -

=, Single- e

© line Text &= Text

= Selection @ .'?.ate and

ime Input

[*] Date Display ! Imagd)

‘»' Movie “ PDF

-~ Phone N

" Number . Button

. Barcode ' Numbering

[@Select the Image field]

Select “Add Photos from
Photos/Albums”

[N Add from Photo/Album

L
[¥] Importand Add @re

Add from Camera
|

®Tap & then circle
an Image field

al
L 7 2 O [a T
View Point Write Erase |Sélect Text

@Select a photo you
want to add

The photo you selected
will then be added

[@Tap >%ﬁf]

S

Field Settings

Border None »

Basic

Background Color None >

Margin Left/Right:2mm >
Display Settings
Layout

Alignment Horizontal Align... >

Alignment Vertical Align Mid... >

()
O]
R D — .
S G + Enter image here ‘ )

You can change a
resolution of an image

. v Follow System Settings =
Low
Standard
High

Original

Edit Settings
Place Holder

Maximum Number
of Pieces

20
——@Resolution Follow System Se... >

Tile Display » @

A new Image field is added

®©
L —— .
¢ ¢ ¢ Enterimagehere ¢ 9 D
S —— .

About the access permission for

photos/videos on your device
(since i0S14)

When you use this function, you are

asked to grant permission to access

either your selected photos only or

all the photos. You can select one

option.

® You can change accessible photo

settings with tapping > “Add
Photo”> “Change Accessible
Photos”

® You can also change it with the
app from iOS “Settings”> “Privacy
& Security”> “Photos”

®Customize the settings of
an Image field

| Tile Display

You can set the maximum number
of Images which can be displayed

22



5-9 Video field

@ Tap & to show the [@Tap > "I\/Iovie”]

toolbox
o I,
= [~
| ‘ ® I
CELI—-
Add Form Components -
‘g v! Checkbox ' Numeric
o -
~-+ Single- oy
" line Text = Text
= : ;1 Date and
% = Selection Time Input
g [*] Date Displdy | ' Image

‘@' Movie ‘ ‘# PDF

- Phone )
2 Number .+ Button

= Barcode " Numbering

A new Video field is
added

g ¢ ' TaptoSetVideo ¢+ D 2

@Select the video

[@Select the Movie field] you want to add

Select “"Add Video from

®You can play the video to
check and tap “Done”

Photos/Albums” ==

Add Video from Photos/Albums  Add Video from Camera  Add Video from Media Server

- Q Photos, People, PI

Tap to Set Video s

» About the access permission for photos/videos
on your device (since i0S14) (P22)

@Tap & then circle
a Movie field

[@Tap ”Play”]
The video starts playing

Mute Audio  Thumbnail Save to Album

Play Clear

v . B
You can add a
bookmark

You can take a screenshot and it will be
added on the page

When you tap the screenshot, it starts
playing from the point the screenshot was
taken

You can mute
the sound

23

You can crop
the video

You can stop playing it by tapping other
areas

You can hide the video scene bar

You can play the video with full screen mode

You can use a picture in picture mode so that
you can play and edit it at the same time




@ Tap & then circle [@Tap "Play”] ®@Tap the bookmark button
a Video Field on a scene that you want to
screenshot as a still image

Play Clear Mute Audio Thumbnail Save to Album

Bookmarks are added

01:44.5/02:15.9

[@Select & to stop playing]

[@Select “Get Still Image” ][@Select "Done” after reviewing the alignment settings]

[ Cancel Arrar;gementof étill Imagesr Done The St”l ImageS Captured fr‘Ol’T] the
pookmarks of the video are added

Get Still Image

‘ @ Inserts 5 still images extracted from Video.

[J Add New Page and Insert Still Images @

Horizontal Position Vertical Positio
| Arrange Hori vter v Center

1 [ 213

How to play a video from a still
image

When you select a still image, the
Number of Still Images/Page @ 3 — V]deo W||| be p|ayed ]n the \/ideo
e ) Field based on the place of the
Margin (Left/Right) @ 0%

Margin (Top/Bottom) @ 0% bookmark

If you add a stillimage and play it,
the video will start playing in that still
image field

24



5-10 PDF Field

[@Add toshowthe |  (@Tap i >"PDF Field" |

toolbox . ‘
_ :wl ® A new PDF Field will be added
™ ®
E Add Form Components -E i‘ ________________ e _?
= “% ‘{J} Checkbox ‘f‘;} Numeric i % E
@ ‘ 5 Single- ‘ & Text E E
“*“ line Text e N ! ¥ «
o ‘{'E} Selection ) _I:I?_ate and ¢ ¢ 4 Tap tO Read PDF | s 0D
o= ime Input ' o
% ‘ [*] Date Display ‘ ! Image H H
[aa]
(] Movie € PDF ]
| g} Phore ‘ i} Button b B D SnEEEEEEE -®
‘{'.} Barcode " Numbering ®

[@Select a PDF Field and select the PDF file that you want to add]

The PDF file you chose was added

Tap to Read PDF

C}> Read From Storage

ﬂ Read from iTunes

1 Read from WebDAV < 2/9 >

@ Read from InOutBox

®Tap & then circle a [@Tap > 1Y ] ®You can customize a PDF
POF Field Field settings
R arAr-akine e ph o =8
| Eolia

Field Settings

@ é Border None >
@ oo @ --mmmmmmmees ? @ Background Color None >
i E Margin Left/Right:2mm >
i 1

E i Display Settings

: (: + Tap to Read PDF + :) Alignment Horizontal Align... >
E E Alignment Vertical Align Mid... >
E E Edit Settings
‘_‘ ____________ S ‘ Place Holder

®

25



5-11 Phone Number Field

®Tap & to show the [@Select +>"Phone Number Field”]

toolbox ® -
& I A new Phone Number Field is
= (] [
aEhle added
L. Add Form Components ®
=] B S S .
D v Checkbox " Numeric 5 1 7 -
@ -~ Single- = T o (: ¢ | Tapto entera phone number. | ? :) po)
T = Text 1 i
line Text |._ % -
= ; ~ Dateand @ ToooommmmmmmmEmmmmmmmmmmoon
L = Selection “* Time Input ®
é’ [*] Date Display | ' Image
‘©. Movie ‘# PDF
-+ Phone o)
! Number @ | 111 Button
. Barcode " Numbering

@ Select a Phone Number Field then
enter phone numbers

The phone numbers that you have

HHH-HHHH- R entered will be shown

1 2 3 © ®

a 5 6 e ¢ «
& <

7 8 9 -

* 0 # space

pause  + wait @

®Tap & > circle a Phone @Tap “OK”

Number Field > “Call” P— R a

B -1 -0
Remove More > Form > Call Tag >

® Cancel ‘ OK

¢ q

D) I You can make a phone call

How to make a phone call when you are on

View mode

You just need to tap a Phone Number Field
to make a phone call after tap L« to change
to View mode
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®Tap & then circle a
Phone Number Field

)

@Tap & >y ] ®@Customize the settings of a
Phone Number Field

o . o ~ = Input Method
Vi::v Pi,;'-l Write E§a§e s?lect 11:& @ Q do Redo - E p
oL mKeyboard
S
] a
Field Settings T -l
° CRCA. |
g Border None > 1 203 a5 6 7 890 .
s ER SRl B G0 UhaN RN EAD D BN Sha
Background Color None > ele«lelal-0 001 1"
Margin Left/Right:2mm > . &3 &l 3 3 B2 B BN S BN
° , ) BE EEE
@ Display Settings
9------ - ° Text Style m Phone Keypad
1 I »""}
: (: o : D Prefix >
® Suffix HHH#H-HHBH-HAHH
@ Alignment Horizontal Align L... > 1 2 3 c
Alignment Vertical Align Mid... >
® 4 5 6
Edit Settings
Input Method Phone Keypad » 7 & 2 -
Place Holder * 0 # space
pause + wait ©

5-12 Command Button

You can add a button which you just need to tap it to start certain actions such as “Print”,
“Send E-mail”, “Open URL"

®Tap & to show the [@Tap + >"Command Button”]
toolbox

g A new Command Button is added
™ 8 o
[EE ) =
e o . 2 @-mmmmmmman
@ Add Form Components = 3 :. ?
- 1 1 -,
‘;ﬂ /! Checkbox 7, Numeric e C ? [ ] M D <
a e
7 Single- = Text ST PO -®
o line Text
® = Selection @; Dateand ©
© Time Inpu
e %] Date Display | ' Image
‘®' Movie # PDF
-+, Phone e
. Number .+, Button ‘
= Barcode "' Numbering
o & Approval
. Approval “ Request
'z Signature

27



[@Tap &+ >y ] @ Tap “Command to Run” then select an

action you want to add to a Command

®Tap & the circle a
Command Button

L AR A IR Y S —— Button
vi::v Point | Write | Erase $elect Text E') b4 hdo Redo E
, " P
= 0 Let's select “Print” as an example
=] e
@ Soc) 7 Field Settings
Field Settings Send E-mail Display Settings
£ Button Design Send to Lapel 2
& | Send to Storage it (]
Dlsplay Settings f BarminiEoldiny ‘Alignment Horizontal Align... >
Alignment Vertical Align Mid... >
Label > Page Protection e
Switch Page . Command to Run Unspecied >
Text Style

Add Pages

Alignment Horizontal Align... > Duplicate Page
Open Note
Alignment Vertical Align Mid... >

Close Note

Open URL

Send Notification ?

You can print based on the two options “Current

Edit Settings

Command to Run Unspecified >

[@Select one]

Print Page“/“All Pages®
| cancel Print Done | You can send an e-mail of “Current Page*/”All Pages” in
Send E-mail “PDF*/”JPEG”/"CSV”/”GEMBA file”.

Page
C] All Pages

Current Page

You can enter the “address®/”subject” in advance

Send to Application

You can send “Current Page*/”All Pages” to other
applications in “PDF*/”JPEG”/"CSV”/"GEMBA file”

You can send “Current Page®/”All Pages” to online
storage in “PDF*“/”JPEG”/”CSV”/"GEMBA file”

You can save a Note/Page Clip in a shared folder

Send to Storage

[@Tap ”Done]

After coming back to the
Command Button settings
screen, you can customize
the other settings such as
‘Button Design”, “Display
Settings” then tap "Done”
after you finished

Save in Folder

Protect Page You can customize which page to protect from editing

You can jump to a page you specify and also change
Maginification Ratio to “Full Paper®/"Paper Width”
You can specify and add new page(s) right after the

current page
You can copy page(s) which has a button inside and

duplicate to a specified location
You can copy work details and duplicate for other day
you specify

Switch Page

Add Pages

Dupulicate Pages

: : Open Note It is useful when you want to open a manual note
P You can specify a page of a Note to open
Close Note You can close a Note you are in and go back to Notes

List

The Command Button was
customized as you did. When
you tap the Command Button,
the action will be started

5-13 Barcode Field

@ If you linkage to “direct”, you can see another option “Send to
Direct”. Please check out User Manual by = >"User Manual”

®OTap & to use the [@Select +>"Barcode Field”]

toolbox ®
I .
Add Form Comppnents A new Barcode Field will be
o . e .
EEE ) g ! Checkbox 177 Numeric added
= ~=» Single- s
g * line Text = Text O]
oz . @ Dateand || = @--rmeeesoees T [ )
‘= Selection “ Time Input ? T ——_—— "
] Date Displhy | © Image (: ? Tap to Read Barcode | 7 D o
(S 2 O B e B B e N ST @ mmmmmmmm—a
‘® . Movie € PDF ¢ 4 ®
©
o --» Phone o
! Number Button
= Barcode [ ] ' Numbering
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@ Tap & then circle a [@Tap & >y ]

Barcode Field

)& 2 T 5
|£ﬁ@

Field Settings

N ~

Updo Redo

L &

View Point

g

Border None >

Basic

Background Color None >
Conditional Formatting None >

Margin Left/Right:2mm >

1 Display Settings

Alignment Horizontal Align L... >

i Text Style

Alignment Vertical Align Mid... >
Display by Barcode None >

Edit Settings
Input Method Camera >
Title when Shooting Hold th... >

Undivide >

Place Holder

ision Settings

How to scan a part of a barcode

@ Customize the settings
of a Barcode Field

» Add a conditional formatting (P42)
Display by Barcode
Display by Barcode

| Cancel Done |

Display by Barcode
) None
(J copeizs
() Qrcode >

Input Method

B Camera

'd the camera of your device up to the QR c

Tap "Division Settings” and specify “Start Position”/"Number
of Characters” then it will display a part of a barcode as you
specified
[ Cancel Division Settings Done ’
Divide O
Start Position
3
Number of Characters
6
001234567895 123456

H Barcode Scanner

Please follow the instruction
guide of Barcode scanner

Here is the instructions in case you select Customize the settings of a Barcode Field (P29) >
“Input Method”> “Barcode Scanner”. Firstly, you need to pair your iPad with a barcode scanner.

Please check on the instruction

[@Tap on a Barcode Field]

guide for a barcode scanner for
pairing steps

| I‘I’apto Read Barcode 9(\5')

[@Scan a barcode with a barcode scanner]

I

001234567895

29

Data is entered

=

001234567895




5-14 Numbering Field

You can use the auto-numbering function in case the
numbers have patterns such as serial numbers

If you add a Numbering Field on a Note template, it will be
auto-numbered in the order you open the template

0001

®Tap B to show the

@Select & > "Numbering Field”

| =k
[EEE ) =t
toolbox | @ i
EEE- Add Form Components EE]
o o
'2 v: Checkbox " Numeric
@ -
= Single- o
*_line Text & Text
rz ) ;- Dateand
% i= Selection *~' Time Input
© “] Date Displ ! Image
i [*] Date Display [e]
‘® Movie ' PDF
Phone 0
2\ Number Button
%. Barcode Numberir@

A new Numbering Field will be added

L L — °
S G e Pleasespecifyanumberingname. | ¢ D
' P
! .
[ o eEEEETEEEEE *

®Tap & then circle a
Numbering Field

[@Tap > §Y ]

@ Customize the Settings of a
Numbering Field

o ~ =
vi::v Point  Write] EréaEe T-|e:t @ EO:[ \gdo  Redo s
e |+
| T
Field Settings
2 Border None >
©
o
Background Color None >
o Margin Left/Right:2mm >
@ Display Settings ] » ] ]
Customize “Numbering Settings
| L SREEETEEEEE . Text Style
(: (: + Please specify a numbering name. + :) Alignment Horizontal Align L... > Choose a ﬂumber‘ing Option from
1 i i 1 .
®------—---- - - - ® Alignment Vertical Align Mid... > the list
® P - ] A v g i 7
Edit Settings MMJ Edit Settings
Numbering Settings Unspec... ).— Test { Numbering Settings Unspec... > ’
Numbering RuleWhen Using... > test [ Numbering RuleWhen Using... > l

When can you do numbering

P Customize Numbering Settings
(P31)

You can save a Note as a template which has a Numbering Field in
a team folder

P Register/use as a template (P11)

B To manually number the template
Tap a Numbering Field to add a number manually when you open
a template

M To do the numbering automatically
Open Note templates in a team folder thus they will be
automatically numbered in the order you open
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(@Tap & > # |
®
|r@ iy

Add Form Components

o ron s .
'g 7. Checkbox 7. Numeric
o -
+7 Single- o
~* line Text = Text
nz . -+ Date and
‘= Selection = fime Input
[*] Date Display = Image
‘= Movie ¥ PDF
-, Phone i
o Number :. Button
. Barcode " Numbering
& > Approval
.-, Approval * Request

! Signature

Batch Add Form Components

= Add Form Component by
Recognizing Rectangle

Management
4. Manage Shared List

" Manage Numbering Setting!

@Tap "Manage

(®Tap "Add" |

Numbering Settings”

{

(@Enter new numbering information and a
password then tap “Done”

Cancel

Add Numbering Settings

Numbering Name

Name

Format Settings

Prefix A

Date Year(YYYY)

Serial Number Settings

Number of Digits 3 Digit(s)

Start Number 1

Auto Reset None
Password

Confirm Password

add @

O MMy (Company-Wide Folder)
O Test (Company-Wide Folder)
O test (Company-Wide Folder)

Done ’
Enter a Numbering Name
Enter Prefix (name/character
v at the beginning of a
numbering)
] Enter Date for the
after Prefix

A20190625002
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Manage Numbering Settings  Close }

®Tap “Close” after you saw the new
numbering in the list

Manage Numbering Settings ~ Close ]

Add > .Iete
O Mwy (Company-Wide Folder)
O Test (Company-ide Folder)
@ test (Company-Wide Folder)
If you want to edit, tick a numbering that
you want to delete and tap “Remo”
Tap to edit a

numbering settings

Change Password

If you forget a password, you need to
ask admin to change it

Admin can change a password by
choosing a numbering and tap “Change
Password”

Manage Numbering Settings Close 1
Add > Delete
O MMy (Company-Wwide Folder)
O Test (Company-Wide Folder)
@9 o=t (Company-Wwide Folder)
o —




5-15 Approval Field

You only need to tap to approve and also check when/who approved

®Tap & to show the [@Tap &> “Approval Field”]

toolbox QI¢ —
Add Form Compohents A new Approval Filed is added
? ‘§ /. Checkbox . Numeric
s o -+ Single- = [
7 line Text = Text i i
"= Selection &) ?ﬁ;:?::ut i } i
o [*] Date Display | ' Image :: e + §TaptoApprove + J D
o ‘! Movie # PDF ' H
0 : i
7 :I:?r:‘:er i Button I '
= Barcode " Numbering & - gesmm=s B @
' Approval Q= Q::;Z\;?I
@Tap & then circle an [@Tap &+ > ] ®Customize the settings of an
Approval Field Approval Field
\I}i::(u F%nt vﬁte Erase Se?e‘ct Telx! E‘) \y—! Uhdo FZZO == E Cancel Imprint Settings Done
el [ S Type
= =) =
® Field Settings \emes/|[\eneey/
? -r""_“-.""““- ? I Border None > Label
i | E Approved Approved
b ! Ll Background Color None > Date Stamp Settings
. : Date Display Format 2024/05/01 > 2023/12/20
> (: : ! : :) Display Settings View Approval Information
. rover
> ; Tap to Approve T Imprint Settings Approved/D... » @ |~
: : Color - > —.
! | Text Style Date Display Format 2024/05/01 >
[ 1
1 1
T ———m—m— 1 Edit Settings
&-------- R * Customize Text Style
@ Place Holder
Notification Settings No > You can Change font
® protect Page T No > style/font size/color
Protect Page You can send notification © You can notify about the location of
You can stop editing messages to other thhe Shargctj Note/Note to members
. WNO need TOo approve
functions any longer members vv.hen you PP
after it is approved approve/reject
PP : o e = 0 Please make sure to close the note
ancel lotification Settings one . . , .
thus the page cannot be before notifying the Note's location
edrted anymore Notification Message
. . At the time of Approval ( Affirmation) ~ Approv...
If you choose “Select”, Cancel Approvalhas been revoked.
the pop-up bellow will be R
shown after you tapped a Users Who Have Access to the Note
Appro\/al F|e|d Notify Note Creator
User Requesting Approval
Is it OK to approve? Approved Users
,,,,,,,,,,,,,,,,,,,,,,,,,,,,, Add Notification >
Approve and Protect Page
Approve
Cancel
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Instruction for Approvers

Open a note that you need to approve

[@Tap an approval ﬂeld] @If a pop-up message is shown, select an option
to approve

©

4
!
.

A new approval stamp is added as the Approval form is
approved © Once an Approval Field is approved, you

9 ‘ no longer select it
Approved

O1f you set for a notification, then the
KB other members will receive the approval
notification

(: + Tap to Approve

Y

@ Please make sure to close the Note if you

approve something
When you tap a aproval stamp, you can check an

approver/date of approval , , _ _
If you tap “Cancel” then the field will be empty. This option
Close PProved \

is only visible for approvers

Canc. App nfo.

24/01/15
Rt o

You can unlock the page when you tap “Cancel” to cancle the
approval

Tap down/right clock on the page in All page> "Page
Attribute”> “Display protection Info”> “Cancel” to unlock it

Open the Note which is approved to check the details

Approved By ANBP D
Approved Date  15/01/2024, 3:22 AM

You can also open a Note from the pop-up message/Notification List

How to open a Note from a notification | How to open a Note from the Notification List

You just need to tap the notification, Tap = > "Notification List” > 5_ .to_ open the approved Note to check
thus the Note approved/reboked will Nofification List close
e open shortly

Y

Note now Note T
i @ From: Af158 From Afd 8%
L Approved. 15 Jan 2024 at 3:24 AM ¥
- - e LT T Approved.

All Normal/Priority Priority

You can check the information

of an approver/Date of Approval
when you tap on an approval It will show a "COPY” watermark on an Approval Field, if you
copy and paste it

If you copy an approval stamp

stamp
A caution message will be shown if you tap a copied approval
stamp
\pproved
Cancel Approval Info Close " " T 1
“4/01/15 Tap .Clear to make /;aw ARMBORT M3
Approved By KR BB the field empty ESe 20— B mzmacr.

B>

Approved Date  15/01/2024, 3:22 AM 20 /1 Stk k
a "“COPY" watermark mg; 5 ms‘;;
i i AKX
is visible even if it is o FEAA
FARAR 2023/0117 11:07

exported as a PDF | |
file
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5-16 Approval Request Field

You can select an approver and request them and also send notifications. Approvers can
check about details on Approval List

®@Tap B to show the
toolbox

=

Basic

[@Select > "Approval Request Field”]

Add Form Components A new Approval Request Field will be
'% v Checkbox {7} Numeric added
3 -
-, Single- o
*_line Text = Text @
P . ;- Date and ®------ =i o
= Selection = Time Input P !
[*] Date Display " Image ' H
o !
‘»' Movie “ PDF . !
(: (: ° | Tap to Request Approval ; D :
) Phone +] Button i :
“° Number . A !
H 1
% Barcode ! Numbering H !
i
o - Approval ® W 4 .
Approval " Request ® ° -@ @

®Tap & then circle an

Approval Request FieIdJ

{@Tap >M?]

@ Customize the Settings of an
Approval Request Field

cm
Le & #
View  Point Write Erpse |Select| Text

>

e Tap to Request Approval

Y

$
o

Cancel

B Type

2oeg

Gakal'1]

Field Settings

N

Redo

Date Stamp Settings

s

Date Display Format

Imprint Settings

View Approval Information

Border None »

Requester

Approver

Basic

Background Color None >

Approval Comments
Color

Display Settings

Date Display Format

Done

2023/12/28

2024/05/01 >

o
- >
2024/05/01 >

Imprint Settings Date Stamp ,-

o

Text Style
Edit Settings
Place Holder

Approval Request

» Customize Text Style (P32)

» Protect Page (P32) Protect Page
Notification settings

Notification Settings No >

No >

You can send notification to members
when it is approved/cancelled

[ Cancel Notification Settings. Done

At the time of Request Requested to %A.
Cancel Request The request has been canceled.
Approval Reminder Please approve it
At the time of Approval ( Affirmation )  Approv.
At the time of Approval ( denial ) Denied.
Remand Remanded.
Cancel Approval has been revoked.

Team Members
Users Who Have Access to the Note
Notify Note Creator

User Requesting Approval

Approved Users

Add Notification 5
User

m\When you request for an approval,
approvers will receive a notification

B \WVhen an approver approves i, the
requester will receive a notification

m\When an approver cancels it, a
requester will receive a notification

© You can send notifications to “Team
Members’/"Users Who Have Access
to the Note"/"Notify Note Creator”
from “Notification Settings”

® You also can send notification
to "Users Requesting
Approval’/"Approved Users” from
“Notification Settings”
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For example, Person A (Requester)
requests an approval from Person B
(Approver) in three days

Cancel Approval Request Done
Title
Text %S%D >
() select from List >
Note20231228 (J Automatic Numbering >

Tap to Approve
Candidates for Request (Users who have Access)
Requested by A& %%,

beadiine:2023/12/31 1500 @ (] Al

Individual Designation wrsve > @
Choice (Affirmation) Approved >
Choice(Negation) >

Remand

«©

Initial Value of the Approval Deadline

(3 No Approval Deadline

Specify by Day 3 Days Later >
(O specify by week >
(O specify by Month >

You can select multiple users in

“Candidates for Request” thus, you

can request for multiple approvals at

once

» Request for multiple approvals at
once (P35)




5-16-3 Request for an approval

5-16-3-1 Request for an Approval on one Approval Request

Field

[@Tap on an Approval Request Field] @Select “Request” after entering the Title/Who

to Request/Deadline

Approve Approve

Tap to Reduest Approval | Tap to Request Approval

Tap to Request Apprq

KB PH

Deadline

After you selected “Request”

Approval Request

Who to Request

This is an example: When a
Person A requests for approvals
from a Person B/Person C

Approve Approve

Note20231228 | Note20231228

Tap to Approve | Tap to Approve

Requested by A%,

usmuUszz 12/3116:00

Requested by AF1205.
Deadline:2023/12/31 16:00

already approved

“Notification Settings”
B Please make sure to close the Note after you created
Request Field

B you are no longer able to select the Approval Request Field as it is

m Notifications will be sent to approvers if you customize them on

\
When you select “Tap to Approve”,
you can remind/cancel it

Approval
Note20231228
W Approved

an Approval

Deadine2uzs/ 3 1640

5-16-3-2 Request for Multiple Approvals At Once Method 1

MCreate an Approval Request Filed which multiple

members are selected in “Candidates for Request” in
[Customize the settings of an Approval Request Field

(P34)]

@Tap & to copy the Approval Request
Field created in @ and paste as you

Tap to Request Approval | <€—(@ S5

@ Select multiple
Approval
Request Fields

need

® . o © . o © . (]

] . e © ° ® L ° d
29

®Tap on one of

[@Tap “Who to Request” to choose a member and tap ”OK”]

the Approval | s 5 '
Request field

SR
= I 2=
597 U CES JIBTL 7 hO=2 220230124
A
FEBA AR LB >

OK
FEAX v
AIAE v
EE v

[@Tap ”Request”]

~TAM |

[EREES |

You can reqguest for
multiple approvals

Froel KBEKA

1R

. Multiple members will be added as

. approvers

How to Remind/Cancel All At Once

Tap “Tap to Request Approval” to remind/
cancel for approvals

| o, BT RO=2 220230124
597 LA i

Bk FEAX v
FEAX AHXE EEH >
wixie v

¥
ERREL | ERES

AGRE FHEAN HRE BRI

=

AERE A

S

Frven 2

P -

T% 5 _ FEAKCHARERRETS

JFRERIE smmsoumAT~THETS
FESANDIEERD KT

» After you tapped “Request” (P35)
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5-16-3-3 Request for Multiple Approvals At Once Method 2

Since Feb,2023, You can request for approvals all together when there are multiple
Approval Request Fields which have one approver each

(@ [Customise the settings of an
Approval Request Field (P34)]
Create and align Approval Request You can register Approval Request Fields as new

. [tems and add them in case you need
Forms which have only one member /
in “Candidates for Request”

[tems can be registered in the toolbox

For more information on how to add
new ltems/register to the toolbox,
access = > “User Manual”

IT you already registered it as an Item, you just
need to align as you want

@Tap & then circle [@ Tap “Form“> “Continue to Enter”J
the multiple

®
Approval Request : : *
Fields ».:: ¢ e i 9
; i ® . o@
®
@Tap on the [@Tap “Request” if “Who to Request” is as you set]
Approval ' e | #R You can request all together
Request Field | TEEeee—— = _ b After tapping
5 ’;1;;:‘:,7m:71102301u » ’lRequeStu (p35)
Gk ., e, [l | BRES| BRSE | RE » How to remind/cancel all
= ="' ez ||ttt s together (P35)

5-16-4 Open a Note which is requested for an approval

Manage approvers

Open the Note which was requested for an approval
You can open a Note via Approval List/Notification/Notification List

How to open a Note via Approval List

In All Notes, You can tap [E > & to see the list of Notes requested for approvals (Approval List)
You can open a Note requested for an approval from “What was Requested”

<) SHE%

EWENELO | ERLILD

e HIRE L8 J—r& SR

Duration”

You can filter with “Location and

R (WREE)

HEA- 2021/12/0116:15 frRBER 7 #20211201 FRES YOU can alSO ﬂlter V\/|th ”NOte Name“/
WEHH
"Title"/"Requester”/"Status”

How to open a Note from notification Open a Note from the Notification List

When you tap a notification, a requested Note || In All Note, tap = > "Notification

will be open ist” ificati
P List” to see the notification. R T -
-~ Tap £7 to open an approved/ @
| g ote now Note 5}
R rom mmen >Q cancelled Note to check i |
e e
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Manage approvers

®Select an Approval @Select an option and A new approval stamp will be added
Request Field ) tap “Execution” I &

FREEER20210610

This is an example when a

Person A'is an approver: AL
= = T = ARBE BB
%u’“‘ KR #:2021/06/13 15:00
: 5 v 7Ly IR
TEAEER20210610 TEAEER20210610 SHEEL DK EURL
. MR 201l06/1315 | BELE LT () o] When you tap on an approval stamp, you
1

survosn | KRES .
SHEELOEE | AREEEAHE You can add

HAPR:2021/06/13 15’0““"? HAFR:2021/06/13 15:00
Q comments

I can see an approver/date of approval

REBIH

FERWEORT L3

v -"' FALRIL TEAEER20210610
P RRER R
If you select "Cancel”, the filed will be made 2021/0¢ #&= R
. . . ERE 2021/06/10 16:27
blank. Please note that this option is only FES ... FELEUL
visible for the approver 1 1

Open an approved Note via Approval List/notification/Notification List and check the
details

When you tap on an approval stamp, you can see an approver/date of approval
If you copy an approval stamp

A “COPY" watermark will be shown if you copy an approval

REEN  ARWEORT  HU3
stamp and paste it
& AL FRABER20210610 You can see a message when you tap on-an approval stamp
A AR AR
2021/0¢ #=* FEAA . .
— ARAR 2021/06/10 16:27 Select Cle.ar to
FEA .. ?E%bgwc make the field
1 ! 2 blank AE—SNEABEETT.

You can also see P . " -
You can see the "“COPY ;;;; ’ ”°23‘;;
comments . A _
watermark even it is - @ FESA
— . ERER 2023/01/17 11:07

exported as a PDF file

aAxXvhk

5-17 Signature Field

You can create a field which adds your signature. This makes it useful when you want to
sign a conctarct with a customer physically

®Tap & to show the [@Tap > “Signature Field”]

toolbox . =)
Add Form Compohents . . . .
o A new Signature Field is added
'g v Checkbox ‘ 71 Numeric ‘ ®
EEE ) (] -~ Single- ‘ 0 Text ‘
g “ line Text o ?‘ ,,,,, "?
nz " -+ Dat d ) 1
# seecton || “5lin ¢ ¢ 4 TaptoSign 4 D
¢
[*] Date Displal ‘ ' Image ‘ | |
|
o “ Movie | pDF | ¢ "
© i Phone ‘ i1 Button ‘ @
oM " Number o
= Barcode ‘ ! Numbering ‘
P A ]
* howowr | = pme
i3 Signature‘
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5-17-2 Customize the settings of a Signature Field

®@Tap & then circle a [@Tap & > J [@Customize the settings of a Signature Field]
Signature Field

You can change the ink color

8y

Field Settings You can notify members when you approve/cancel
Border DL with a signature

Background Color None

Lk & ¢ & | &

% £ J S
View Point Write Ergse | Select Text

Notification Settings

Margin Left/Right:2mm
Notification M

Display Settings

®

Text Style
[ L ([ ]

Team Members
Color

¢ ¢ ¢ TaptoSign * 2 oSS

Place Holder

Approval request

Users Who Have Access to the Note
Notify Note Creator

User Requesting Approval

@ Notification Settings Approved Users
Add Notification
User

5-17-3 Signing a signature

[@Tap a Signature FieIdJ [@Sign and tap “OK”

- lge

the members will receive notifications if you
customize the “Notification Settings” to do
SO

You can no longer select the Signature Field
as it has been confirmed

A “Copy” watermark will be shown if you copy and paste the signed Signature
Field
An error message will be shown when you tap the signed Signature Field

Check the information of the Signature If you copy the Signature

Tap “Clear” to erase sur  sEmEORR  MUS
Approval Info a signature - NIKRRETT,
ARE SEET
Apgroved By AEPH /~\ }—T : ‘% ARE 2021/07/16 10:21
Approved Date  08/01/2024, 3:42 PM 7 N\

AT 2%

I'ﬂ”‘!’
//
-‘//‘ ﬁ The watermark (COPY) will be

displayed even if it was exported in

When you select “Clear”, the Field will be a PDF form
made blank

This option is visible only for the one who

approved

38



©. Advanced settings of form
components

6-1 Register/use Shared List

Managing lists in text/CSV files using the Shared List function is very convenient.

The form components that are compatible with Shared Lists are “Text Input
Field”/"Number Input Field"/"Selection Field”

6-1-1 Save a Shared List in Storage

You can create/save a Shared List in Storage with the rules below

File extension Descriptions

txt one list item = one text line

data devided with a comma/tab
csv/tsv row 1l:row name -
after row 2 : list orders

* 1 You can use Numeric field as well in case a list of orders are made of only numbers

6-1-2 Register a Shared List

Open a Note that is located in a Team Folder

@ Tap “Import”> choose a

B>+ Tap a Team Folder that
®Tap B >H> "Manage 2R storage and a file

Shared List” you want to register a
Shared List to

;‘ | lTl—j &ﬁ? Manage Shared List

Add Form Components Ej &1 import Reset Password Read From Storage
§ Checkbox Numeric Jd Read fromiTunes
B ﬁ:;g-:—z;t Text 8] Read from WebDAV
= Selection e ot If you create a Shared List with (& Read from InOutBox
Date Display Image the option “(Company-Wide
>\ Movie & PDF Folder)” then all the organization
; phone Button members can use it
%. Barcode Numbering
Approval Approval This option is not visible when you [@Tap “Close” ]

open a Note in a Private Folder

#. Signature

Batch Add Form Components Manage Shared List

Add Form Component by

* Recognizing Rectangle ‘ @ Enter " L|St Nameu/u PaSSWOFd " 1 import Reset Password

Management

4. Manage Shared List then tap ”Done"

Manage Numbering Settings

Register List

List Name

text

Please set a password to update or delete this list.

Admin Password Settings

Confirm Password

[ the file name will be displayed as default }

To avoid unwanted changes,
it is recommended to set a
Password.

a New Shared List will be added
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6-1-3 Customize the settings of a Shared List

The steps for using a Shared List in “Text-Input Field”/"Number Input Field”/"Selection
Field” are all same. Thus it will be explained with only the “Text-Input Field” as an example

®Tap & then circle @Tap @ Tap “List [@Tap “Use Shared I_ist”]
a Text-Input Field > §Y Settings”

List Settings

Options
Flld: No Choices
Border e

m Define List
Background Color - —

Conditional Formatting None > (] Use shared List
Margin Left/Right:2mm >

Display Settings

Text Style

Approval request

Alignment HorizontalAlign L... >
Alignment Vertical Align Mid
Display by Barcode ~ None >

Edit Settings

Define List

Input Method Keyboard and...

N
Lt Serng? Enter inputs in the box of “Add
pecerierr Option” then tap + to add as a
Maximum Length 100 )
Alphanumeric Input No ‘ ‘St
Edit Possible »
= Item/Template Settings
Initial Date When Used Date...
®Select a List you want to use and tap Pisbiem
“ DO ne “ Report
Seleet Ui Now you can select options
from the Shared List that you
(Company-Wide Folder) have Se|eCted ear‘”er
X . Read From Storage
list_X4% I
Enter text here ﬂ . Read from iTunes
list_T1& 2
Enter ®) € Read from WebDAV
Package BISEMkER T EF— IS (1.1.0) Enter @ e s LG B
Property_Types_Jp Enter E €
GEMBA 7 7') % o
\ 7 #FE . .
You can add a new list with
Eis0EE ” !
i Import and Add
K BO®
. J

Filter with searching

You can filter ootions with words in the search bar
The search bar appears when there are over 20 lists
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6-1-4 Update a Shared List

The Shared Lists that were customized as form components get automatically updated

when you update Shared Lists

Open a Note which has a Shared List that you want to update

®OTap & >+ > “Manage [@Choose the Shared List that you wish to update]

Shared List”

[@Enter password and tap ”OK”]

|ré‘%if

Add Form Components

@Tap “Update List"> select a file as the updated
version of the Shared List

(2}
@ Checkbox Numeric
o s
Single- N "
line Text Text List Settings
= Selection Date and
Time Input 5 ) ] .
Date Display| | ! Image S Ul The Shared List will be updated
. Movie ¢ PDF List Name
i 7(/\
. Phone Button list_X4
Number
%' Barcode Numbering Please set a password to update or delete this list.
Approval Change Password Settings
Approval Request

#. Signature

Batch Add Form Components

Add Form Component by
* Recognizing Rectangle

Management

4. Manage Shared List

Manage Numbering Settings

Confirm Password

You can change passwords }

Created 6 Oct 2022 at 1:19 PM
Modified 6 Oct 2022 at 1:19 PM

Author

T ’ You can check the details (which include the
creator/updater) of the Shared List

[@Tap ”Done”]

Choose a location from where you
want to import a new Shared List

In case you forgotten a password for a
Shared List

Only the Admin can change the password
1. Tap > &+ > “Manage Shared List”
2.Tap “Reset Password”

Manage Shared List

& Import Reset Password

3.Reset a password that you want to
change

Reset Password

4.Enter a new password and tap “Done”

Reset Password

The password list_X4% will be reset.

Change Password Settings

Confirm Password
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6-2 Add a new Conditional Formatting

You can know how to add Conditional Formattings in a Checkbox
The steps are the same for the “Numbering Field”/"Text Input Field”/"Barcode Field”

{@Tap % then circle} [@Tap >%ﬁ?] [@Tap “Conditional Formatting”]

a Checkbox
l @Tap “Add Rule”
Gl to add rules
Field Settings
% Border None >
@ Background Color None > @]

@ Conditional Formatting None >
¢ [ ° ® Marai LefyRight2 5 Checked
» argin eft/Right:2mm
S C ° D 4 D
. i Unchecked
° ° ® Display Settings
@ Label >

Checkmark Display Checkbox >
Text Style

Alignment Horizontal Align L... >

®Customize the new Rules
and tap “Done”

®Tap “Done” to save
a new rule

Conditional Formatting

Add Rule

Add Rule

Rule
e = Checked

= Unchecked
Style

Border Unchange
Background Color Unchange You can delete a
Color Conditional Formatting

You can create multiple rules
and drag to sort orders.
The first line rules will be
prioritized

eg. how conditional formatting

can change the appearences on a
Checkbox

]

| [f Unchecked: Background Color
is Pink

m [f Checked: Color is Red

|___| Submitted

4

Submitted
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Number Input Field

Enter number here

ter than or Equal to
than

rEqual to

2

eg. If a Number Input Field is empty: Background Color is Yellow
If the input number is from 1 to 3: the Background Color is Pink

=

Add Rule

Rule

The value is blank
Style

Border

Background Color

Color

Edit Rule

Rule

Between
1
Style
Border
Background Color

Color

Unchange

Unchange

Unchange

Unchange

Text Input Field

Enter text here

» TBC trash

eg. If the input texts are “TBC": the Background Color is Pink

Cancel Conditional Formatting Done .
Cancel Edit Rule Done
Add Rule
Is Blank gl
4 Text Contains v
| Is Not Blank
|
| Equivalent to TBC
Not Equivalent to Style
Starts with Border Unchange >
Ends with
Background Color >
Contains
. Color Unchange »
Not Contain
Barcode Field
eg. If it starts with “1": the Background Color is Pink
to Read Barcode » 12345670
Cancel Conditional Formatting Done
‘ Cancel Add Rule Done
Add Rule }
Is Blank ‘ N Rule
| vV Text Starts with v
Is Not Blank |
Equivalent to 1
Not Equivalent to |
4 | Style
Starts with Border Unchange >
Ends with
‘ Background Color >
Contains
ot Corian Color Unchange »
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The things you can do with a Spreadsheet are explained as follows:
You can check the explanation in the User Manual with = > “User Manual”

The following are the steps on how to add a new rule in a Spreadsheet

OTap & then @Tap a cell> “Conditional ®Tap “Add Rule”

circle a Formatting” and select a rule
Spreadsheet u l
1uLaLivli i I . . |
| Expiry Date: ‘ 2024/01/22 | Not Empty
TRUE
fnc. Eﬁl MetaMolJi e

Total

I Equal to the Following Value

Fix Rows and Columns  Sort > Clear > Cut Copy ChartArea Conditional Formatting | Not Equal to the Following Value

Cell Format > Display Format > Data Validation | Greater than the Following Value

— [ ) - 2 = = | Greater than or Equal to the Following Value
Ladder num
. Less than the Following Value

| Less than or Equal to the Following Value
Text Matches the Following

= Text does not Match the Following

| Text Starts with the Following

& Text Ends with the Following
Text Contains the Following
Text does not Contains the Following

Within the Following Range

i Outside the Following Range

@Tap “Done” after
customizing a new rule

Cancel Conditional Formatting L Done
Done

[@Tap “Done” after the new rule is shown in the Iist]

Cancel Add Rule Add Rule
Applicable to |
B2 @ Empty B2
Rules Less than O B2
Empty
You can tap to delete
Cell format rules
() Boud Do not Change
1 .
O N You can also create multiple rules
You can drag to sort orders as the rules
() Textcolor Do not Change >

in the first lines are always prioritized

Inc. N
ne [ifil MetaMoJi
Total
TEL
Mr/Ms.
Product Name .Quar\tity Unit Price  Amount
Ladder .num
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You can set a Data Validation for users to inout correct information
[@Customizing Data Validations]

@Tap M then circle a

Spreadsheet You can select and customize data validations
from the following options: “Numeric
[@Tap a cell> "“Data Valldatlon”] Value’/"Date and Time"/"Period’/"String
Length”/"Checkbox”/"Shared List"/"Formula”
vuuaLivii : : : ' e -
Expiry Date: 2024/01/22 Cancel Data Validation Done ‘
‘ Inc. IB,T! MetaMoJi Rule Settings
Total | Type All Values >
[ | Input Messa  A|| values st Display >

Fix Rows and Columns  Sort > Clear > |Cut Copy ChartArea Conditional Formatting

Error Messa Numeric Value Display >

Cell Format > Display Format > Data Validation X
ogeee e r oo y ~ o ity Unitp Dateand Time
Ladder num um  Period
[ J

String Length

Checkbox

Shared List

:’: —

This is an example of when you want users to input numbers starting from 1 to 30

Cancel Data Validation Done M r fM S

Rule Settings Number not valid
Type Numeric Value > e Q u a ntity l
Conditions Between the Following Values >

BT LS 32 I Confirm as it is
1

Maximum Value
30 - Caution! Re-enter
NBLE Messace Display > Please enter the number

< ween 1to 30

Error Message Display > Cancel
1 I

Cancel Input Message Done
Display Input Message ()
Cancel Error Message Done
Tilte

Caution!
{ Display Error Message O
+ Message
| 9 Stop Information

Please enter the numbers between 1 to 30
Message

Number not valid

v
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You can create a new chart from the Spreadsheet in GEMBA Note
Please note that this function is available only in the IOS/Windows versions. You cannot create a chartin
GEMBA Note in Android ver

P

@ Tap ' then circle a
Spreadsheet

Fix Rows and Columns  Sort > Clear > Cut Copy ChartArea Merge Conditional Formatting

CellFormat > Display Format > Data Validation

1 ABCInc.  123Inc.
| 2 |2024/01/05 1 15
| s |2024/01/10 5 20
| 4 |2024/01/15 10 10

|5 |2024/01/20 15 5

(®Tap acell>drag® to
select cells that have data
for a chart

(.

[@Select “Chart Area”]

@Tap “Add Chart ®Tap "Done” after ®Select an added Chart Area>

" H H " "
Area customizing the tap “New Chart
Chart Area Settings
Close Chart Area Edit Close Chart Area Edit
Add Chart Area ALC5 > Namo Add Chart Area AC5 >
Participants from 2 companies
\ Participants from @ ompanies A1:C5
‘ Data Range AICS >
Series Column >

Regard first column as Category Header o

Regard the first row as Series Header D

New Chart (f)—]

[@Select a Chart Type> tap “Done”]

e shartlyoes D“”*‘ How to check the details of a chart

Vertical Bar Chart
Tap a chart> “Chart”

_
Line Chart
\/ ®

Scatter Plot

You can jump to an
original spreadsheet

Horizontal Bar Chart

ABCIKY Chart
2024/01/05 1 Jump to Spread:heet

Add Legend

Change Area

[ ] ° Change Chart Type

20 Chart Settings

> -,
> 8 «

A new chart is created

'S

You can add a Iegend}
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